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Introduction 

This course teaches the basics of creating websites with Macromedia 
Dreamweaver. Dreamweaver is a powerful and sophisticated Web authoring 
program, yet it is easy to use and is an excellent tool for beginning webmasters. 
This course will take you through the creation of a simple Web page, complete 
with images, links, and email links. 

In these lessons, we'll make use of tables. Tables are an excellent way for you to 
organize and create a simple Web page. One of the great strengths of tables is 
that they also work well in more sophisticated pages. There are other ways to 
accomplish the same things, such as layers or frames, but tables are generally 
simpler to use and easier to update and maintain. 

Course Objectives 

• Set up a website on a computer 
• Create a blank Web page 
• Enter and manipulate text 
• Create a table 
• Insert an image 
• Insert a hyperlink 
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Five Steps for Creating a Web Site 
 
Step 1: Needs Assessment 

• Determine the goals and objectives of the Web site. 
• Decide how the goals and objectives can best be met. 

 
Step 2: Site Design 

• Break the information into logical sections. 
• Sketch pages on paper: if it won’t fit on an 8½ by 11 page, consider 

breaking it into two Web pages. 
• Design template(s), if any. 
• Make decisions about content, links and general organization; it may 

help to draw or graph the general structure of the site. 
• Develop or locate graphics for the site. 

 
Step 3: Implementation 

• Create HTML Web pages, using Dreamweaver or other tool(s). 
• Include appropriate internal and external links. 
• Remember that content is far more important than bells & whistles. 
• Thoroughly test every aspect of the site. View on as many different 

browsers/computers as possible. 
• Upload the finished site to your server. 

 
Step 4: Refine the Site 

• Gather feedback about the site. 
• Add and/or modify content. 
• Add features as you gain confidence and skills with your tools. 
• Keep your purpose for the site in mind at all times. 

 
Step 5: Maintenance 

• Continually evaluate, test and update the site. 
• Consider periodic redesign work to keep your site vibrant and 

interesting for your visitors. 
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A Quick Tour of Dreamweaver  
 
Let's start by looking at the Dreamweaver MX screen. Click on any of the 
labels to see a description of that feature. 

The Dreamweaver Workspace: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Document Window - This is the document window, where you edit Web 
pages. It opens automatically when you open Dreamweaver. 
 
Site Panel - This panel has several functions. It shows the folders and files 
used in your website, and you can use the panel to move files and folders 
around within the site, or to perform other site maintenance tasks. By 
choosing from the pull-down menus in the panel, you can choose from the 
various Web sites that you work on (department site, class sites, etc.), and 
you can choose between the Local View (the copy of your website that 
resides on your computer) and the Remote View (your website on the server 
that you upload it to) 
 
Property Inspector - This tool enables you to view and manipulate the 
properties of the various elements of your Web page. For example, if you 
click on an image on your page, it shows the properties of the image, such 
as its size, its filename and where it is stored in your folders. If you highlight 
text, it shows the text color, size, font, justification, etc. 



Dreamweaver 100 

Copyright © 2008. Northside I.S.D. Technology Training and Development Services. 
All rights reserved.  

3

 
Status Bar - The left side of the bar shows the HTML tags that affect the 
page element where your cursor is currently located. On the right side of the 
bar, you can see the size of your workspace in pixels. It also shows the total 
size of the page (in Kilobytes), including images. 
 
Active Webpage - Shows the page you are editing. If multiple page are 
opened, the active webpage will be in white, while the others are in light 
gray. 
 
Code View & Design View Buttons - These buttons allow you to toggle 
between working in the normal Dreamweaver MX environment (Design View) 
and working in HTML (Code View). The button between them (  ) shows 
Code and Design Views simultaneously in a split screen. 
 
Objects Panel - This panel is used to insert a variety of objects, characters 
and features into your Web page. Use the tabs at the top of the panel: 
 

 
to select what types of objects are available to you at the click of a mouse. In 
the Common Objects Panel, the most useful items are probably: 
 

 Image - allows you to browse for images to insert into your Web 
page. 

 Table - use this tool to place a table in your Web page. You can 
choose the number of rows or columns, the width of the table, 
the size of the table's border, etc. If you change your mind about 
one of the table's features later, just click on the edge of the 
table or the space between two cells, and the table's attributes 
will appear in the Property Inspector, where you can make 
changes. 

 Horizontal Rule - this button places a horizontal line (horizontal 
rule -- or HR) in your page. Use the Property Inspector to set the 
width of the HR, either in pixels or as a percentage of the 
available space. 

 Hyperlink - although this is not the only way to insert a link in 
your Web page, it is certainly one of the easiest. A dialog 
window appears when you click on this button. Type whatever 
you want your visitors to click on in the Text: box, and click on 
the Browse for File button (     ) if you are linking to one of the 
pages in your site. If you want to link to a file outside your site, 
type or paste its complete Web address in the Link: box. You 
can safely ignore the other items in the window. 

 Email Link - this tool is even easier than the hyperlink. Simply 
type whatever you want your visitors to click on in the Text: box, 
and type the email address you wish to link to in the E-Mail: box.

 
Upload (Put) / Download (Get) Arrows - This button opens a menu 
allowing you to upload (put) or download (get) the page you are working on. 
A similar pair of buttons appears at the top of the Site Panel. 



Dreamweaver 100 

Copyright © 2008. Northside I.S.D. Technology Training and Development Services. 
All rights reserved.  

4

Create a Site with Dreamweaver 

Dreamweaver allows you to create an entire website on your computer and 
thoroughly test it before uploading anything to a server where others can see 
it. After you post the site to the server, you'll have two complete copies of the 
site: one on the server and one on your computer. You work on your Web 
pages on your computer and upload them to the server when you're ready. If 
two or more people maintain a site, Dreamweaver's synchronizing system 
helps to protect you from over-writing each other's work. 

Creating a site in Dreamweaver is easy. First, make a folder to serve as your 
local directory somewhere on your computer. Your desktop is a good place. 
Make as many subdirectories within your folder as you think you might need. 
You can always add more later, but an images subdirectory is a good idea 
as a place to keep all of the graphics for your site. 

An example of a site -- set up in a folder on a computer's desktop -- is shown 
below. There are directories for all of the types of files and Web pages the 
author plans to post, including images and pdf (Adobe Acrobat) files. Note 
that everything is in lower case, with no spaces. This is a good idea, 
especially if your server is a UNIX machine. It's also a good idea for all of the 
filenames in your site. 

  

 

 

 

 

 

 

 

 

Make a Never Upload folder somewhere outside of your site. If you create a 
Web folder, the Web folder could contain both the Never Upload folder and 
the folder that holds your website. The Never Upload folder is a handy place 
for Fireworks .png files, Microsoft Word .doc files, and other files that you 
used in making the site but which are not used in the finished site and do not 
need to be uploaded. 

Tip: Create a Never Upload folder



Dreamweaver 100 

Copyright © 2008. Northside I.S.D. Technology Training and Development Services. 
All rights reserved.  

5

Site Setup 

1. Click on Site at the top of the screen and select New Site...  
2. Choose the Advanced tab at the top of the Site Definition for 

Unnamed Site window. 

 

 

 

 

 

 

 

 

 

 

Local Site Definition 
Dreamweaver uses two sites: the Local Site, on your computer, and the 
Remote Site, on the server where the Web site resides. You create the Local 
Site and use Dreamweaver to upload the site when it is ready. 

1. The Local Info window will appear. Complete the following fields: 
2. Site Name: Give your site any name you wish. Capital letters and 

spaces are OK here.  
3. Local Root Folder: Use the browse button (         ) to find and select 

the folder where your Web site will be stored on your computer.  
4. Refresh Local File List Automatically and Cache: Check both of 

these boxes. Don't worry about the Default Images Folder or the 
HTTP Address: boxes.  

 

 

 



Dreamweaver 100 

Copyright © 2008. Northside I.S.D. Technology Training and Development Services. 
All rights reserved.  

6

 

 

 

 

 

 

 

 

 

 

 

Remote Site Definition 
This is where you enter the information about your server. If you don't know 
the address of your server and your username and password, skip this step 
and click        .     . 

1. Don't click               yet. Choose Remote Info (on the left, under 
Category), instead.  

  

 

 

 

2. The Remote Info window, when it opens, it will appear almost blank, 
with the pull-down menu:  
 
 
visible. Choose FTP, and the window should change to something 
similar to the image to the right. 
 
 
 

If you did click the OK button: 

1. Choose Site from the menu at the top of the screen, then select 
Edit Sites...  

2. Select your site from the list that appears in the Edit Sites window 
and click Edit...  

3. Choose Remote Info and continue with step 2 below. 
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3. As with the Local Info, you only have to fill in a few pieces of 
information: 

• Access: Choose FTP. 
• FTP Host: Type in the address of your server. For most 

Northside departments and schools, this is: www.nisd.net. 
• Host Directory: Your account will automatically take you to the 

appropriate directory, in most cases. If you are working under a 
department or campus webmaster, check with that person for 
directory information. You can also call the Web Office at: 397-
7648. 

• Login: Your username. 
• Password: Your password. If the Save box is checked, you'll 

be able to upload and download files without having to type in 
your password each time. 
 

4. When you're done, click . That's the basics of setting up a site 
within Dreamweaver. 
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Design a New Web Page 

The natural impulse for most of us is to start typing and clicking and just 
design the page as we go. This sometimes works, but it's almost always 
better to take the time to design the page on paper. After all, if you can't 
create what you want with pencil and paper, how can you do it with 
Dreamweaver? 

The example below uses a table to encapsulate the entire Web page. An 
advantage of this is that the entire page can be kept to a particular width. At 
650 pixels, this page would "fit" on almost any computer monitor currently in 
use. By centering the table, we can "frame" it on the visitor's screen. A table 
also allows you to carefully organize how things will appear on the page. This 
is a more elaborate sketch than some of you are likely to need, but it shows 
many of the page features very clearly. The table and some notes are in red, 
and the page content is shown in black. 

The table in the sketch below has one column and five rows: 

Row One: Page title 
Row Two: Horizontal rule (HR) 
Row Three: Main page content, including text and two photos. 
Row Four: HR 
Row Five: Links to other pages in the site 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Experienced 
webmasters 
frequently sketch 
out new pages. 
It's much faster to 
start with a 
sketch and to 
build the page 
once, than it is to 
rework major 
parts of a page 
after creating it. 
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Create a New Web Page 

To make the page from the sketch, we start by creating a table. This table 
will contain the entire page and keep it to a width that almost any computer 
monitor can display. The table also helps us to arrange the elements in the 
page and to create a Web page that looks the way we want it to look, on a 
wide variety of computers. 

Page Title 
 
Page titles are very important. They allow you to identify your page without 
using up valuable space in the main part of the page. Most search engines 
look at the title, so a good, descriptive one gives your page a better chance 
of being found. Additionally, search engines often list Web pages by title 
when displaying the results of a search. A descriptive title helps a visitor to 
choose your page instead of someone else's. 

To give the page a title (which appears in the blue bar at the top of a visitor's 
browser, type a title into the white Title: box in one of the toolbars near the 
top of the screen. If the box is not visible, follow these steps: 

1. Click on Modify in the Menu Bar at the top of the screen. 
2. Choose Page Properties from the pull-down menu. 
3. The Title box will read Untitled Document. Delete those two words and 

type your page title. Press             . 

Create the Table 

1. Click the Insert Table button (  ), which is found in the Common 
Objects Panel, or choose Table from the Insert menu. 

2. We have the opportunity to set all of the table's attributes at the start, 
but tables are easy to modify later, if that's needed. We want our table 
to have the following attributes: 
 

 

 

 

 

3. After the table is inserted, use the Property Inspector to center it in 
the page.  
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Table Attributes 
 Rows and columns are self-explanatory, but some of the other attributes 
may be confusing: 

 

Save the Page 

1. Click on File in the Menu Bar at the top of the screen. 
2. Save the file as you would a word processor file. If it's the main page 

of your Web site, call it index.htm. 

Preview the Page 

Press the [F12] key to preview your page in a Web browser. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Width Width in tables is set in either pixels, or as a percent of 
the available space. Tables can be put inside one 
another, so a table set inside ours would have a 
maximum width of only 650 pixels, even if the Width 
was set to 100%. 

Border The thickness of the lines around a table and setting 
its rows and columns apart. A zero Border means that 
the table itself will be invisible to someone viewing the 
page, but it will still serve to contain the page and to 
keep things where we want them.  

Cell Padding The distance -- in pixels -- of objects within table cells, 
from the cell walls 

Cell Spacing The space -- in pixels -- between cells 

If the table is 
not selected, 
click on any of 
the borders 
between cells. 
Now go to the 
Property 
Inspector, click 
the Align box, 
and change 
the alignment 
to Center. 
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Cascading Style Sheets: 
Changing the “Default” Font of a Web Page 
Instead of having to highlight all of the text in a page, why not use a style 
sheet to change it all at once? You can still highlight any text and apply a 
different style at any time. 
 
Set a Style for the Body Text 
The <body> tag in a Web page is where the content is placed. By redefining 
the body text, you can affect all of the text in the page. Effectively, you are 
setting the “default” text, using a style sheet. 
 

1. Open the CSS Panel. 
2. Click the New CSS Style icon ( ). 
3. Choose Tag for Selector Type. 
4. Select body from the Tag pull-down menu. 
5. Define the style in This document only. 
6. Click [OK]. 
7. In the CSS Style Definition window, choose Arial, Helvetica, san-

serif from the font pull-down menu. 
8. Type 1.0 in the Size box, and choose ems from the pull-down next to 

it. 
9. Click [OK] and watch as all the text in the Web page changes to the 

Arial font! 

Text and Page Formatting 

We have to always remember that text does not behave the same in Web 
pages as it does in a word processor. If you put more than one space 
between two words, the extra spacing is ignored. Pressing the [Enter] key in 
Dreamweaver moves the cursor down two lines instead of the customary 
one. This is the equivalent of the HTML Paragraph (<p>) tag. To move down 
just one line, hold down the [Shift] key and press [Enter]. This equates to the 
HTML Break (<br>) tag. 

Let's start by adding the header to the page. In the topmost cell of the table, 
type the following: 

 Archaeology 101  
  Aerial Tour 

Remember that you need use [Shift] [Enter] to move the cursor down just 
one line.  

 

 To move the cursor 
 down two lines 
 (skipping one line), 
 press: 
 

[Enter] 
 
 To move down just 
 one line, press: 
 

[Shift] [Enter] 
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Now let's format the text to look the way we want. 

1. Highlight both lines of text of the header (the text you just typed). 
2. In the Property Inspector, look for the Format pull-down menu, and 

change it Heading 1. 
3. Open the file text.doc (provided by your instructor). 
4. Copy and paste the text into the third row of the table. Notice how the 

text is automatically formatted to a standard Arial font. 

Horizontal Rules (HRs) 

Now we're ready to put in the HRs 

1. Click within the second cell of the table to locate your cursor there. 
2. Click on the Horizontal Rule button (  ) in the Common Objects 

Panel . Notice that the Property Inspector allows you to change 
several attributes of the HR, including its Height (thickness of the 
line), Width, and whether it is shaded or not. 

3. Follow steps 1 and 2 to place an HR in the second-to-last cell.  
4. Save and Preview the page (Press the [F12] key to Preview). 

Images 

Images can make a big difference in how people see your Web page. Great 
images can add color and interest and can illustrate whatever information 
you're trying to get across to your visitor. Poorly-chosen images can be 
distracting, but the worst "crime" with graphics on a Web page is to use 
images that are too large. They can slow down the loading of your page so 
badly that some visitors will never return. 

Follow a few simple rules when you add images to a page: 

• Choose images carefully. A few great pictures are better than several 
mediocre ones. 

• Keep them as small as possible! This speeds page load time. 
• If you want to show large pictures, use "thumbnails" -- small images -- 

as links to larger images. 
• Don't use Dreamweaver or HTML to resize images! They appear 

smaller, but they take just as long to load. Use Adobe Photoshop, 
Macromedia Fireworks, Microsoft Photo Editor, or some other 
program to really resize your Web images. 

• Use the Alt attribute to add text as a courtesy to vision-impaired 
visitors and others. 

• Be creative and have fun! 
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Photos are provided by your instructor. The photos are Copyright © 2003 by 
Marlo Brown. You have permission to use the photos, for educational 
purposes only. 

Inserting Photos into a Web Page 

Dreamweaver makes it extremely easy to add an image to a page: 

1. Place your cursor at the beginning of the first paragraph of text. 
2. Click on the Image button (  ) on the Common Objects Panel. 
3. Browse to find the cessna_small.jpg image and click  

to insert the image.  
4. Repeat the process to insert the pismo.jpg image in the middle of the 

second paragraph. 
5. Save and Preview your page. 

Next, we'll learn how to wrap the text around the image, how to add notes to 
images, and how to use thumbnails as links to bigger images. 

Images, Part II 

At the end of the last section, we inserted two images into a bunch of text, 
but it probably didn't look the way we wanted. Your page may look like the 
example below: 
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Wrapping Text Around an Image 

This is another aspect of Web page building that Dreamweaver makes 
extremely easy. 

1. Click on an image to highlight it. The Property Inspector will display 
the image’s attributes. 

2. Click the Align pull-down (                           ), and choose Left or 
Right. The text should wrap around the image. 

3. Save and Preview. 

Notice that an image location symbol (  ) appears where you had the cursor 
when you inserted the image. You can click on this symbol and drag it 
around on the page to move the image. 

Adding "Alt" Notes to Images 

Alt, as in Alternative Text, is what will be visible to a visitor if something 
prevents your image from displaying. When the image does appear, the Alt 
text will appear if a visitor puts his or her cursor on the image, almost like a 
floating caption. These notes are also what a vision-impaired person's 
browser will "read" to them. In order to make your page as accessible as 
possible, you should add Alt text to every image. It's easy to do: 

1. Click on the aerial photo image. 
2. In the Alt box of the Property Inspector, type the following: 

 
                    Aerial view of Pismo Beach, CA 
 

3. Save and Preview. Hover over the images to see the Alt text. 

Using Thumbnail Images 

Thumbnails offer Web designers the best of both worlds: you can create a 
page with small images that load quickly, yet you offer larger images to your 
visitors with just one click of the mouse. 

This will be your first exposure to linking. Links really are the most useful 
aspect of the Internet, and they are not difficult to create with Dreamweaver: 

1. Click on the airplane image. 
2. Look in the Property Inspector for the Link box. Look just to the right 

of the box for a Browse for File ( ) button. Click on it and browse to 
find the cessna.jpg image. 
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Go back to the Image Properties of the smaller image and add the following 
words to the Alternate Text:  
 

Cessna 210 airplane. Click to see a larger image 

Links 

Now it’s time to add some links to our page. You've already made a link with 
the thumbnail image, so this will be easy. There are several ways to make a 
link in Dreamweaver, the easiest is: 

1. Highlight the text -- or click on the image -- that you want your visitor 
to click on for the link. 

2. Look in the Property Inspector for the Link box. Look just to the right 
of the box for a Browse for File ( ) button. Click on it and browse to 
find the file or image that you want to link to within your website. If the 
item you are linking to is outside your site, type its entire Web address 
in the Link box. The example below shows a link to the NASA site.  

 

Let’s add some links to our Web page. These links will go at the bottom of 
the page. 

1. In the bottom cell of the table, type: 
 
Society for California Archaeology | Society for American Archaeology 
 
The character between the names of the two associations is called the 
“pipe” and is commonly used to separate text links. It is often found on 
the same key as the “backslash” ( \ ) character. 
 

2. Highlight the name of the first society. 
3. In the Link box, type: 

 
                          http://www.scahome.org/ 
 

4. Highlight the Society for American Archaeology text, and follow the 
steps above to link it to the following: 
 
                          http://www.saa.org/ 
 

5. Save and Preview your page. 

Independent Practice:



Dreamweaver 100 

Copyright © 2008. Northside I.S.D. Technology Training and Development Services. 
All rights reserved.  

16

Special Characters 
Symbols, such as the ones for copyright (©) or trademark (™), some 
fractions (¼, ½, and ¾), and even the special characters from several 
languages, are created with special HTML codes in Web pages. 
Dreamweaver allows you to insert them into Web pages very easily. 
 
To insert a copyright symbol at the bottom of your document: 
 

1. Place your cursor to the right of the two links that we just made.  
2. Look at the Status Bar to make sure that your cursor is not “inside” 

the link to the Society for American Archaeology. The Status Bar 
should look something like this… 
 
 
 
 
 
 
 
 
 
…but not like this: 
 
 
 
 
 
 
 
 
The <a> tag in the Status Bar indicates that your cursor is being 
affected by the previous link. If this happens, click off to the right of the 
linked text, and the <a> tag should disappear from the Status Bar. 
 

3. Press [Shift] [Enter] to move your cursor down one line. 
4. Type: 

 
      Copyright 2005, Sonoma State University. All rights reserved. 
 

5. Place your cursor after the word “Copyright,” and select Special 
Characters from the Insert menu. 

6. Choose Copyright from the menu that pops up.  
 
 

Status Bar Cursor 
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Notes: 
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